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NEW QUESTION 1

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked
Live.

Box 2: Select Restore on the previous version of the app. Restore an app from your account

Open powerapps.com, and then click or tap Apps in the left navigation bar.

Near the right edge, click or tap the info icon for the app that you want to restore.

Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 2

- (Exam Topic 1)

You need to configure the app to meet the requirements.

Which object properties should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Fill

Scenario: You must display a visual indicator in the app so that sales representatives know whether the app is offline before submitting reports.

Fill — The background color of a control. Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-screen https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-form
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NEW QUESTION 3

- (Exam Topic 2)

You need to implement the change requested by the operations manager. Which control should you use?
BF70D5D

A. Camera

B. Shape

C. Add picture
D. Image

Answer: D

Explanation:

Scenario: The operations manager asks that the time tracking app display the employee’s photo once they have scanned their badge.
Image control in Power Apps is a control that shows an image from, for example, a local file or a data source. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-image

NEW QUESTION 4

- (Exam Topic 2)

You need to meet the requirement for the time tracking app.

Which controls should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Timer

A Timer control in Power Apps is a control that can determine how your app responds after a certain amount of time passes.

Box 2: Barcode scanner

The Barcode scanner control for canvas apps scans barcodes, QR codes, and data-matrix codes on an Android or iOS device.

Box 3: Image

Image control in Power Apps is a control that shows an image from, for example, a local file or a data source. If you add one or more Image controls to your app,
you can show individual images that aren't part of a data

set, or you can incorporate images from records in data sources.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-new-barcode-scanner https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/controls/control-image

NEW QUESTION 5

- (Exam Topic 2)

You need to configure the system to meet the requirements.

What should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: 1:N

Scenario: A sortable listing of all in-process jobs from the Job Setup table, by customer, start date, and product.

Box 2: User or Team owned

Scenario: Employees must only be able to access their own time tracking records from the app.

User or team: Data belongs to a user or a team. Actions that can be performed on these records can be controlled on a user level.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/types-of-entities

NEW QUESTION 6

- (Exam Topic 3)

You are creating a model-driven app that allows users to create and edit a list of existing accounts. You need to display a list of all active accounts.
Which user interface components should you use?

A. view

B. gallery

C. data table
D. form

Answer: C

Explanation:

Imagine that you have a collection of data (such as a list sales orders, a set of service tickets, or a directory of contacts), and that you want to show this data in
your Microsoft PowerApps app in a tabular format, where each column represents a field and each row represents a record. In the past, you might have been able
to roughly simulate this visualization, although the process required some effort. However, we’ve been listening to your requests and are happy to announce that
you can now quickly and easily achieve this very typical visualization by using the new Data table control that has been recently added to PowerApps.

Reference:

https://powerapps.microsoft.com/fr-fr/blog/introducing-the-data-table-control/

NEW QUESTION 7

- (Exam Topic 3)

You create a canvas app.

A user is not able to determine which field currently has focus. You run App checker to identify errors. You need to verify that the focused border thickness is set to
a value greater than zero.

Which section of the App checker results should you check?

A. Rules

B. Performance
C. Accessibility
D. Runtime

Answer: C

Explanation:

The Accessibility checker classifies each issue as an error, a warning, or a tip based the issue's severity. Issues include:

Focus isn't showing

When the FocusBorderThickness of a control is set to 0. It is good practice to ensure a proper color-contrast ratio between the focus border and the control itself
so it's clearly visible.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 8

- (Exam Topic 3)

You are configuring a new Common Data Service environment by using the Power Apps Maker portal. You need to create an entity that uses the prefix xyz.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-entity

NEW QUESTION 9

- (Exam Topic 3)

You create a canvas app named Hardware Order that suggests computer hardware to customers.

A value must be entered for the EmployeelD field when creating a new order if the value in the OrderType field does not contain the prefix test.
You need to configure the business rule.

Which two actions should you perform? Each correct answer presents part of the complete solution.

NOTE: Each correct selection is worth one point.

A. Set the scope of the business rule to Entity.

B. Add a Recommendation action and configure it to enter the order type.

C. Set the scope of the business rule to All Forms.

D. Use the following condition expression:(OrderType Does not begin with [test]) AND (Modified By Does not contain data)

Answer: AD

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 10

- (Exam Topic 3)

You create a canvas app within a Power Platform environment.

You need to identify potential accessibility issues for the canvas app before making the app available to other users.
Which tool should you use?

A. Portal Checker
B. App Checker
C. Solution Checker

Answer: B

Explanation:
Find accessibility issues
* 1. In the upper-right corner of Power Apps Studio, select the icon for the App checker.

* 2. In the menu that appears, select Accessibility.

A list of issues appears, sorted first by severity and then by screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 10

- (Exam Topic 3)

An administrator plans to create and deploy dashboards for use only by sales associates. The dashboards will display the current sales pipeline, open cases,
recent major wins, and key opportunities by postal code. Sales associates must be able to act on the specific data displayed in dashboards.

You need to create the dashboards.

Which type of dashboards should you create? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: User

Type of dashboard: If you want your dashboards to be available across the organization and do not want to manage the access levels at a more detailed level, you
might want to create an organization-owned dashboard. However, if you are concerned about the access privileges and security of your dashboard, consider
creating a user-owned dashboard where you have more control on who can access it.

Box 2: Single-stream

The single-stream dashboards display real-time data over one stream based on an entity view or queue. The single-stream dashboards are typically helpful to Tier
2 service leads or managers, who monitor fewer, but more complex or escalated cases.

Reference:

https://docs.microsoft.com/en-us/powerapps/developer/model-driven-apps/create-dashboard https://docs.microsoft.com/en-us/powerapps/maker/model-driven-
apps/configure-interactive-experience-dashbo

NEW QUESTION 12

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use a Key Phrase Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
The key phrase extraction prebuilt model identifies the main points in a text document. Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase

NEW QUESTION 13

- (Exam Topic 3)

You have a solution that contains a Power Automate flow, an environment variable, and a model-driven app. Which three steps should you perform in sequence?
To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Adjust the version number. Step 2: Select the managed solution.

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Step 3: Publish all changes. Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-Unmanaged/td-p/495685
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NEW QUESTION 17

- (Exam Topic 3)

You are designing a canvas app that will be used by all users including users who have vision impairments. Which outcome is achieved by each action? To
answer, drag the appropriate outcomes to the correct actions.

Each outcome may be used once, more than once, or not at all. You may need to drag the split bar between

panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/sv-se/powerapps/maker/canvas-apps/accessible-apps

NEW QUESTION 20

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:
* 1. On the Home tab, add a screen.

* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 23

- (Exam Topic 3)

You create multiple apps as part of an unmanaged solution. You need to move the apps to another environment.

You need to pick the appropriate solution type for each requirement.

Which types of solutions should you create? To answer, drag the appropriate solution types to the correct requirements. Each solution type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Unmanaged

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Box 2: Unmanaged

Box 3: Managed

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 25

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use an Entity Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

Al Builder entity extraction models recognize specific data in the text that you target based on your business needs.

The model identifies key elements in the text and then classifies them into predefined categories. This can help you transform unstructured data into structured
data that's machine-readable. You can then apply processing to retrieve information, extract facts, and answer questions.

Note: Create a canvas app and add the text recognizer Al Builder component to your screen. This component takes a photo or loads an image from the local
device, and then processes it to detect and extract text based on the text recognition prebuilt model. If it detects text in the image, the component outputs the text
and identifies the instances by showing a rectangle for each instance in the image.

Reference:

https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/ https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognizer-
component-in-powerapps

NEW QUESTION 27

- (Exam Topic 3)

You create an app with multiple screens.

Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.

You need to create a reusable gallery that displays information based on the current record.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

NOTE: More than one order of answer choices is correct. You will receive credit for any of the correct orders you select.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Step 1: Add a gallery control Add a gallery to a blank screen
* 1. On the Insert tab, select Gallery, and then select Vertical.

* 2. On the Properties tab of the right-hand pane, open the Items list, and then select your Gallery Step 2: Add a screen
Add a gallery in a screen

* 1. On the Home tab, select New screen > List screen.

A screen that contains a Gallery control and other controls, such as a search bar, appears. Step 3: Add an input property

Input property is how a component receives data to be used in the component. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-gallery https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component

NEW QUESTION 31
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